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آیا تا به حال پی برده اید

  چگونه می توان طرح خود را به قالب JPG تبدیل کنید؟
  تصاویر گرافیکی با قالب JPG کجا کاربرد دارند؟

 چگونه می توان از اشکال دوبعدی، اشکال سه بعدی ایجاد کرد؟
 کاربرد گروه کردن اشکال چیست؟

 چگونه می توان با استفاده از جلوه های گرافیکی، تصاویر را ایجاد کرد؟

هدف از این واحد شایستگی، چگونگي كار با ابزار پیشرفته نرم افزارگرافیکی Illustrator است.

استاندارد  عملکرد

با استفاده از ابزارهای پیشرفته محیط نرم افزار  گرافیکی، درج نماد، استفاده از سبک و جلوه گرافیکی، رنگ آمیزی 
اشیا، طراحی اشیای سه بعدی، انتخاب و تنظیمات مد رنگی را براساس دانش کسب شده، انجام دهد.

  واحد یادگیری 2 

شایستگی كار با ابزارهاي پیشرفته گرافكيي
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 كارگاه 1      طراحی لوگوی پرچم جمهوری اسلامی ایران

1 یک سند جدید باز کنید.
در پنل بازشده، زیرمجموعه Advanced گزینه‌ای با نام Color Mode وجود دارد که دارای دو مد رنگی 

RGB و CMYK است )شکل 63(.

شکل 63ـ تعیین مد رنگی

مد رنگی : در طبیعت تعدادی رنگ اصلی وجود دارد که از ترکیب آنها می توان رنگ های جدیدی ایجاد کرد. 
رنگ‌های رنگین کمان در واقع ترکیبی از رنگ های مختلف هستند. انسان نیز همیشه از طبیعت برداشت کرده 
و همان الگوها را در تکنولوژی‌ها استفاده کرده است. اگر کمی با رنگ ها و سیستم های دیجیتال کار کرده 
باشید، حتماً متوجه شده‌اید که رنگ ها در صفحات وب و نمایشگرها با صفحات چاپ شده، اندکی متفاوت اند 
و هر کدام دارای استاندارد و قالب بندی هستند. در این بخش برای شما تفاوت دو قالب اصلی رنگ بندی در 

رایانه به نام‌های RGB و CMYK را معرفی می کنیم.
 ،)Magenta(سرخابی  ،)Cyan( فیروزه‌ای  آبی  رنگ  چهار  ترکیب  از  رنگ‌ها  رنگی،  مد  این  در   :CMYK
زرد)Yellow( و سیاه )Black( به دست می‌آیند. از مد رنگی CMYK برای چاپ روی كاغذ استفاده می‌شود.

RGB: در این مد رنگی، رنگ‌ها با ترکیب سه رنگ قرمز )Red(، سبز )Green( و آبی )Blue( به وجود 
می‌آیند. با تغییر دادن مقدار هریک از این سه رنگ، می‌توان رنگ‌های بسیار زیادی به وجود آورد. این نوع مد 
رنگی بیشتر برای كارهای تلویزیونی و رنگ‌های استاندارد صفحه نمایش استفاده می‌شود. این سیستم رنگ، 

دارای 16 میلیون رنگ است.
لوگوی نشان داده شده وسط پرچم جمهوری اسلامی ایران با چه فرمی ترسیم شده است؟ در این بخش قصد 

داریم روش اجرای لوگوی پرچم ایران را با اســتفاده از برش دایره و 
چندضلعی ها، آموزش دهیم.
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در جدول ٤ نام رنگ‌های موجود در مدها را به همراه مفهوم آنها بنویسید.

جدول 4ـ مدهای رنگی

RGBCMYK

2 تصویر آماده را وارد کنید.
کلیک  با  و  کرده  وارد  را  آماده  لوگوی  تصویر   File/place مسیر  از 

کردن تصویر را ثابت کنید )شکل 64(.

3 میزان شفافیت تصویر را کم کنید )شکل 65(.
بعد از انتخاب تصویر از نوار کنترل مقدار Opacity را کاهش دهید.

4 تصویر را قفل کنید.
با انتخاب مســیر Object/Lock/Selection تصویر را بر روی صفحه 

قفل کنید. با این روش تصویر جابه جا نمی‌شود.

5 یک بیضی مماس بر تصویر لوگو ترسیم کنید )شکل 66(.

شکل 64

شکل 65   ـ تغییر میزان شفافیت تصویر

فعاليت 
كارگاهي

شکل 66
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فعاليت 
كارگاهي

با استفاده از ابزار Selection و با کلیک و کشیدن ماوس بر نقاط محیط دایره، می توان آن را تبدیل 
به بیضی کرد.

شکل 67

Shape Builder شکل 68ـ استفاده از ابزار

الف

6 بیضی دوم را به روش گفته شده، بر خطوط محیطی داخلی لوگو ترسیم کنید )شکل 67(.

7 قسمت مشترک را جدا کنید )شکل 68(.
ابزار  انتخاب  از  انتخاب کنید. بعد  را  ابتدا هر دو بیضی      ب(  برای جدا کردن قسمت مورد نظر )شکل 68   
    الف بکشید. هنگامی که دو قسمت با  Shape Builder ماوس را در جهت فلش مشخص شده در شکل 68   
یکدیگر ادغام شدند ابتدا ابزار Selection را انتخاب کنید سپس روی بخش ادغام شده کلیک کنید تا از بقیه 

شکل جدا شود. سپس این بخش را انتخاب کرده و با زدن کلید Delete آن را حذف کنید.

ب

کاربرد سایر ابزارهای شکل 68 را در جدول بنویسید.

Live Paint Selection ToolLive paint Bucket

یادداشت
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شکل 70

شکل 71

شکل 72

8 یک قرینه عمودی از شکل ایجاد کنید 
)شکل 69(.

در پنل Reflect می‌توان از شکل انتخاب شده 
در جهت عمودی یا افقی نسخه قرینه ایجاد کرد.
در بخش Axis تنظیمات را وارد کنید و روی 

دکمه Copy کلیک کنید )شکل 69(.

را ترســیم کنید  لوگو  نیم دایره داخل   9
)شکل 70(.

Reflect شکل 69 ـ پنل

1 2 3 4

10 لوگو را تکمیل کنید.

یک شش ضلعی رسم کرده، سپس با استفاده از ابزار Direct Selection سه نقطه پایین شش ضلعی را فعال 
کرده و با ماوس بکشید تا برانتهای الف، مماس شود )شکل 71(.

Shape Builder فضای  11 با اســتفاده از ابــزار 
مشترک را یکی کنید )شکل 72(.

1

2

3
4

5
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شکل 73ـ مراحل ترسیم تشدید

12 شکل تشدید را ترسیم کنید )شکل 73(.
ابتدا دایره‌ای رســم کنید، ســپس یک نسخه مشابه از آن ایجاد کنید طوری که بر بخش بالای تشدید مماس 
باشــد. سپس یک نسخه مشــابه از دو دایره رسم شده ایجاد کنید که بر بخش پایینی تشدید، مماس شود. با 

استفاده از ابزار Shape Builder فضای مشترک را جدا کنید.

1 2 3 4 5

13 تصویر اصلی لوگو را حذف کنید.
با دابل کلیک کردن، تصویراصلی لوگو از حالت قفل خارج می شود. با 

فشردن کلید Delete، آن را حذف کنید. 

14 اشکال را گروه کنید.
با اســتفاده از ابزار انتخاب Selection با کشیدن ماوس همه شکل 
 Ctrl+G ترسیم شــده را انتخاب کرده و با اســتفاده از کلید میانبر

شکل را گروه کنید.
این دســتور این امکان را به کاربر می‌دهدکه تغییرات و جابه جایی را 

یکباره بر روی همۀ شکل ایجاد کند.

15 لوگو را رنگ کنید.

16 سند را با قالب EPS و Ai ذخیره کنید.

شکل 74

آنچه آموختم:

...................................................................................................................................................................................... 1

...................................................................................................................................................................................... 2

...................................................................................................................................................................................... 3

برداشت
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 كارگاه 2     طراحی پرچم جمهوری اسلامی ایران

1 سه مستطیل یک اندازه ترسیم کنید.
 هرکدام از مستطیل‌ها را طبق کد رنگ نشان داده شده 

در شکل 75 رنگ آمیزی کنید.

2 از لوگوی ایجاد شده در کارگاه قبل یک نسخه 
مشابه ایجاد کنید )شکل 76(.

شکل 75ـ رنگ آمیزی مستطیل شکل 76

Warp شکل 77ـ تنظیمات

3 شکل به دست آمده را گروه کنید.

گزینۀ معادل کلید میانبر CTRL+G چیست؟كنجكاوي

4 به شکل انحنا بدهید.
 Object/Envelope Distort /Make with Warp با انتخاب مسیر
پنــل Warp Options را فعال کــرده، تنظیمات را اعمال کنید 

)شکل 77(.

می‌توانیم از این پنل برای منحنی کردن متن و اشکال 
استفاده کنیم. در بخش Style می‌توان حالت انحنای  شکل 

را تعیین کرد.
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فعاليت 
كارگاهي

سایر سبک‌های موجود در پنل Wrap Options را اجرا کنید.

5 انحنای شکل را ویرایش کنید.
با انتخاب مسیر Object/Envelope Distort /Reset with Mesh و 
تعیین تعداد سطر و ستون، شبکه توری را فعال کنید )شکل 78(. 
با انتخاب ابزار Direct Selection و کلیک کردن بر نقاطی که روی 
با جابه جایی و  ایجاد می‌شود که  ایجاد شده دستگیره‌هایی  تصویر 

حرکت دادن آنها می‌توان تصویر را تغییر شکل داد )شکل 79(.

Mesh شکل78 ـ تنظیمات شبکه شکل 79

6 سند را با قالب Ai و JPG ذخیره کنید.	
در این مرحله، یاد می‌گیرید که چگونه کار هنری یا طرح خود را به قالب JPG تبدیل کنید تا بتوانید در 

وب گاه ها یا چاپ کردن از آن استفاده کنید.
وقتی قصد دارید پرونده خود را به JPG تبدیل کنید گاهی ممکن است متوجه فضاهای اضافی شوید که در اطراف 
 Crop تصویر قرار دارند. دلیل آن وجود تصاویر پنهان شده در زیر ماسک است. برای حل این مشکل، باید یک
Area مشخص کنید تا برای Illustrator تعریف کنید که به جای خروجی گرفتن از همه قسمت های تصویر، فقط 
از فضاهای مشخص شده خروجی بگیرد. با کشیدن یک کادر در اطراف تصویری که می خواهید خروجی گرفته 
شود، آن را مشخص کنید. کادر را انتخاب کرده و به مسیر  Object/Artboardes/Fit to Selected Art  بروید 

)شکل 80(.

شکل 80
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Export شکل 81ـ کادر

شکل 82ـ تنظیم ذخیره تصویر برای چاپ

سپس به مسیر File>Export رفته و در قسمت File type گزینه JPEG را انتخاب کنید )شکل 81( و دکمه 
Save را بزنید. پنجره تنظیمات JPEG ظاهرخواهد شد، بسته به اینکه تصویر را برای وب گاه ذخیره می کنید یا 

برای چاپ، ممکن است لازم باشد تنظیمات و تغییرات شکل 82 را اعمال کنید.

    ذخیره کردن تصویر برای وب گاه یا نمایش روی صفحه نمایشگر
کیفیت )Quality(: بین 6 تا 8

 درجه وضوح )Resolution(: برای نمایش و وب گاه ها که نیاز به حجم کم و سرعت بالا است از عدد72یا 
96 استفاده می‌شود.

    ذخیره کردن تصویر برای چاپ
کیفیت: روی 12 تنظیم شود.

 درجه وضوح: روی High قرار بگیرد.
کیفیت  بهترین  با  را  سند  کاربر  است  نیاز  چاپ  برای 
می‌شود  پیشنهاد   300 عدد  که  کند  ذخیره  حجم  و 

)شکل 82(.
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 شرایط عملکردشایستگی ها
نمرهاستاندارد )شاخص‌ها/داوری/نمره دهی(نتایج ممکن)ابزار، مواد، تجهیزات، زمان، مکان و ...(

شایستگی‌های غیرفنی

مدیریت کیفیت،پایش شاخص های کیفیت ـ 
تفکر خلاق ، برقراری ارتباط بین پدیده های 

قدیم و جدید ،خلاصه سازی ایده هاـ زبان 
قابل‌قبولفنی

اتصال  بررسی  شامل  پروژه  نهایی  کیفیت  به  توجه 
صحیح ترسیمات و مفاصل و تناسب جلوه و سبک 
 - رنگ آمیزی  طراحی-  موضوع  با  استفاده  مورد 
نوآوری در ترسیم- رعایت حق مالکیت معنوی تصاویر

2

رعایت ارگونومي  ـ كنترل حفاظتي ایمنی و بهداشت
الكتركيي و الكترونكيي تجهيزات

غیرایجاد اسناد الکترونیکی کاهش مصرف کاغذتوجهات زیست‌محیطی
قابل‌قبول

1توجه به ایمنی و بهداشت محیط کارگاه
به‌کارگیری خلاقیت در طراحینگرش

UI مخفف عبارت User Interface به معنای واسط کاربری است. در بحث فناوری اطلاعات به هر چیزی که از 
طریق فعل ‌و انفعال با آن بتوان با صفحه‌نمایش دستگاه‌هایی مانند رایانه، تلفن همراه، تبلت و... ارتباط برقرار کرد 
واسط کاربری گفته می‌شود. واسط کاربری شامل تصاویر، متن‌ها، دکمه‌ها، دیاگرام‌ها، ماژول‌ها، جداول، ویدئوها 

و همچنین رنگ و مکان آنها است.
امروزه نقش طراحان واسط کاربری بسیار مؤثر است. تارنما، نرم‌افزار و برنامه های کاربردی تلفن همراه که 
ظاهر مناسبی نداشته باشد هرقدر هم محتوای مناسبی داشته باشد نمی‌تواند آن‌چنان‌که شایسته است در 

جلب ‌توجه مخاطب خود موفق باشد.

 كارگاه 3    طراحی واسط کاربری   

جدول ارزشیابی شایستگی های غیرفنی، ایمنی و بهداشت و توجهات زیست محیطی

 شرایط عملکردمراحل کار
نمرهاستاندارد )شاخص‌ها/داوری/نمره دهی(نتایج ممکن)ابزار،مواد، تجهیزات، زمان، مکان و ...(

تنظیمات  مد رنگی 

مکان : کارگاه استاندارد رایانه

تجهيزات: رایانه ا ی که نرم‌افزار گرافیکی 
روی آن نصب باشد

زمان: 10 دقیقه

بالاتر
 از حد انتظار

تنظیــم مــد نمایــش یــا چاپــی بــرای ســند ـ  
ــام اشــکال ـ  ــر ـ ادغ ــزان شــفافیت تصوی ــر می تغیی
ــروه  ــکل ـ گ ــی از ش ــذف بخش ــکل ـ ح ــه ش تجزی
بــا   jpg خروجــی  گرفتــن  اشــکال ـ  کــردن 

تنظیمــات دلخــواه

3

در حد انتظار

تنظیــم مــد نمایــش یــا چاپــی بــرای ســند ـ  
ــام اشــکال ـ  ــر ـ ادغ ــزان شــفافیت تصوی ــر می تغیی
ــا  ــی jpg ب ــن خروج ــکال ـ گرفت ــردن اش ــروه ک گ

پیش‌فــرض تنظیمــات 

2

پایین‌تر
از حد انتظار

1تغییر میزان شفافیت تصویر

ارزشیابی مرحله 1
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واسط  داریم  قصد  آموزشی  کارگاه  این  در 
کاربری زیر را طراحی کنیم.

پژوهش
 UX چیست؟

شکل 83

1  یک سند با ابعاد 768 ×1024 پیکسل 
ایجاد کنید.

2  طرح اولیه را ایجاد کنید.
واسط  اولیه  طرح  هندسی  اشکال  کمک  به 
کاربری را ایجاد کنید. برای ایجاد حالت فنری 
موجود در طرح می‌توانید بعد از ترسیم اولین 
آن  از  مشابه  نسخه  یک   Alt کلید  با  دایره، 
 Ctrl+D ایجاد کنید و با زدن کلیدهای میانبر
را  بعدی  تعداد که لازم است دایره‌های  به هر 
یک  ابتدا  فنر  بخش  ترسیم  برای  کنید.  ایجاد 
مستطیل گوشه گرد ترسیم کرده، یک گرادیان 
سفید به خاکستری به آن اعمال کنید. سپس 
ایجاد  برای  کنید.  عمل  دایره‌ها  تکثیر  مشابه 
مستطیل‌های  از  نیز  راست  سمت  دکمه‌های 
را  آنها  و  کنید  استفاده  هم‌اندازه  گوشه گرد 

پشت مستطیل اصلی طرح ببرید.



ل: طراحی گرافیکی پودمان او ّ

45

3  یک جلوه گرافیکی مناسب اضافه کنید.
با استفاده از کتابخانه‌های مفید پنل Graphic Style به‌طور مثال Buttons and Rollovers به هر بخش 
جلوه مناسب اضافه کنید )شکل 84(. برای دسترسی به کتابخانه‌ها از منوی پانل سمت راست استفاده کنید.

4 سایه‌های طرح را ایجاد کنید.
یک مستطیل گوشه گرد با کد رنگ bbbdc0# و 
با اندازه دکمه‌های سمت راست ترسیم  متناسب 
 Gaussian Blur گزینه  از  استفاده  با  و  کرده 
کنید.  را محو  Effect>Blur مستطیل  از مسیر 

سپس آن را به پشت دکمه منتقل کنید.

5  نمادها را به طرح اضافه کنید )شکل 85(.
پنل Symbols حاوی نشانه‌ها و نمادهای مفید 
 Web Icons کتابخانه  از  است.  کاربردی  و 
نمادهای متناسب را به طرح خود اضافه کنید.

شکل84  ـ اعمال جلوه گرافیکی به طرح

شکل 85  ـ درج نماد

پژوهش
برای ویرایش و تغییر رنگ یک Symbol چه باید کرد؟

طرح  به  را  موردنظرتان  تصاویر  و  متن‌ها   6
اضافه کنید.
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واسط کاربری شکل 86 را طراحی کنید.
فعاليت 
كارگاهي

شکل 86

  Blend كارگاه 4     طراحی به کمک جلوه 

شکل 87

جلوه  کمک  با  را  گل  تعدادی  کارگاه  این  در 
Blend ترسیم می‌کنیم.

پودمان اولفیلمهای پودمان اول

فیلم         ها
درباره     ما

پودمان پنجم
پودمان چهارم
پودمان سوم
پودمان دوم
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1  یک سند با ابعاد دلخواه ایجاد کنید.
2  یک گلبرگ رسم کنید.

با ابزار Pen Tool یک منحنی ترسیم کنید )بخش 1 شکل 88(. برای قسمت Fill یک گرادیان با تنظیمات 
مشخص‌شده در تصویر ایجاد کنید )بخش 2 شکل 88(. دقت کنید که قسمت Stroke بدون رنگ باشد.

شکل 88  ـ تعیین رنگ گرادیان قسمت Fill منحنی

Stroke و Fill شکل 89  ـ جابه جایی رنگ

با کلیک روی نماد Swap Fill and Stroke جای رنگ‌های 
همچنین   .)89 )شکل  کنید  عوض  را   Stroke و   Fill
 Object>Transform در مسیر Reflect به‌وسیله گزینه
یک نسخه مشابه از منحنی گرفته و در محل موردنظر قرار 

دهید.

3 جلوه Blend را روی شکل اعمال کنید.
گزینه  کنید. سپس  انتخاب  را  ترسیم‌شده  مسیر  دو  هر 
اجرا   Object>Blend مسیر  از  را   Blend Options

کنید. )شکل 90(

Blend شکل 90ـ تنظیمات جلوه

جا به جایی رنگ ها
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4 شکل ایجادشده را حول نقطه پایین گلبرگ دوران داده و در محل موردنظر قرار دهید.
برای ایجاد یک نسخه چرخش یافته از گلبرگ، در کادر تنظیمات ابزار Rotate زاویه چرخش را 30 درجه وارد 

کنید، سپس با استفاده از کلید میانبر این عمل را به تعداد لازم تکرار کنید.

5  گلبرگ‌های کوچک‌تر را اضافه کنید.
مراحل پیشین را با منحنی کوچک‌تر و با مقدار Specified Steps برابر 30 انجام دهید )شکل 92(.

شکل 91ـ تعیین زاویه چرخش

شکل 92ـ افزودن گلبرگ های کوچک به طرح

6  ساقه‌ها و برگ‌ها را نیز به طراحی خود اضافه 
کنید.

7  پس‌زمینه طرح را در لایه جدید ایجاد کنید.
کد  با  و یک مستطیل  فعلی  لایه  زیر  یک‌لایه جدید 
رنگ   FEFEF6# در این لایه ترسیم کنید، به‌طوری‌که 
کل صفحه را بپوشاند. مستطیل ترسیم‌شده یا لایه را 

قفل کنید.
8 با تکرار مراحل چند گل دیگر به طرح اضافه 

کنید )شکل 93(.

شکل 93
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Zig Zag شکل 94 ـ تنظیمات جلوه

شکل 95

9 آب زیر گل‌ها را رسم کنید.
با رنگ آبی و ضخامت  ابزار Line Tool یک خط  با 
 Zig Zag 3 زیر ساقه‌ها رسم کنید. سپس دستورpx
را از مسیر Effect>distort & Transform انتخاب 

کنید )شکل 94(.
یک نسخه مشابه از خط ترسیم‌شده در پایین صفحه 
ایجاد  را  موردنظر  Blend طرح  با جلوه  و  قرار دهید 

کنید.

10  هاله گل‌ها را ترسیم کنید.
با  و  کنید  ایجاد  موجود  لایه  دو  بین  دیگر  یک ‌لایه 
اجرای  و   #FCEE21 رنگ  کد  با  دایره  یک  ترسیم 
جلوه Gaussian Blur از مسیر Effect>Blur مقادیر 

مختلف را امتحان کنید تا به نتیجه مطلوب برسید.
11 انعکاس ساقه‌ها در آب را اضافه کنید.

از  با استفاده  از ایجاد نسخه‌های مشابه از ساقه،  پس 
ایجاد  را در خط‌ها  Zig Zag حالت موردنظر  دستور 
و سپس دستور Blur را با مقدار کم بر روی ساقه‌ها 
 Opacity میزان Transparency اعمال کنید. در پنل

هر یک از ساقه‌ها را کاهش دهید )شکل 95(.

 شرایط عملکردمراحل کار
نمرهاستاندارد )شاخص‌ها/داوری/نمره دهی(نتایج ممکن)ابزار، مواد، تجهیزات، زمان، مکان و ...(

استفاده از نماد،
 سبک و جلوه گرافیکی

مكان  : کارگاه استاندارد رايانه
تجهيزات  : رایانه ای که نرم افزار گرافیکی 

روی آن نصب باشد
زمان  : 20  دقیقه

به کارگیری نمادها ـ سبک گرافیکی ـ جلوه و لایه ها در بالاتر از حد انتظار
پیچیده طرح های  3ایجاد 

2درج نماد ـ ساخت نماد ـ اعمال سبک گرافیکی و جلوهدر حد انتظار

پایین‌تر
1درج نماداز حد انتظار

ارزشیابی مرحله 2
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 اینفوگرافیک

را  به مهمانی دعوت‌ شده‌اید. کدام‌یک شما  است. فرض کنید  از هزار کلمه  بیش  ارزش یک تصویر  گاهی 
سریع‌تر به مقصد می‌رساند؟ نشانی مقصد یا کروکی؟ در حقیقت بیشترین دریافت ما از محیط اطراف به‌وسیله 
قوه بینایی صورت می‌گیرد. مغز ما انسان‌ها تجزیه، تحلیل و ذخیره اطلاعات به‌صورت دیداری را با سرعت 
بیشتری انجام می‌دهد. به نظر شما اثرگذاری و ماندگاری متن در مخاطب بیشتر است یا تصویر؟ چرا برای 

ارائه اطلاعات به‌جای متن از اینفوگرافیک استفاده می‌شود؟
 )graphic( گرافیک  و   )information( اطلاعات  واژه  دو  ترکیب  از   infographic اینفوگرافیک  واژه 
از داده‌ها )data( و اطلاعات )information( است که به  اینفوگرافیک نمایش دیداری  تشکیل‌شده است. 
کمک عناصر دیداری نظیر تصویر، متن، نمودار، نقشه، دیاگرام و اشکال گرافیکی به‌منظور ارائه ساده، مؤثر و 

جذاب اطلاعات تهیه و طراحی می‌شود.

اینفوگراف های زیر را بررسی کرده و درباره مزایا و معایب هرکدام در گروه بحث کنید.
فعاليت 
گروهی
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اینفوگرافیک ها بر اساس شیوه پیاده‌سازی به چهار دسته اصلی طبقه‌بندی می‌شوند:
از  1ـ ایستا )Static(: کلیه اطلاعات به‌صورت یک تصویر واحد نمایش داده می‌شوند. Illustrator یکی 

ابزارهای تولید اینفوگرافیک است.
2ـ پویا )Dynamic(: اطلاعات به‌صورت متحرک و پویانمایی ارائه می‌شوند. Swish یکی از نرم‌افزارهای 

تولید پویانمایی است.
3ـ تعاملی )Interactive(: اطلاعات در بستر وب و دیجیتال با تعامل کاربر خواهد بود.

استفاده  اینفوگراف ها  نوع  این  تولید  برای  کپتیویت  نظیر  چندرسانه‌ای  تولید  نرم‌افزارهای  و  جاوااسکریپت 
می‌شوند.

4ـ فیزیکی )Physical(: اطلاعات در قالب یک حجم یا ماکت سه‌بعدی نشان داده می‌شود.

پژوهش

کروکی چه نوع اینفوگرافی است؟كنجكاوي

چگونه یک اینفوگرافیک خوب طراحی کنیم؟
مرحله اول : انتخاب موضوع اینفوگرافیک

مهم‌ترین هدف ایجاد اینفوگرافیک ارائه بهتر، ساده‌تر و جذاب‌تر اطلاعات باارزش است. موضوع موردنظر علاوه 
بر جذاب بودن باید کاربردی نیز باشد.

مرحله دوم : جمع‌آوری اطلاعات
اطلاعات جمع‌آوری‌شده پیرامون موضوع اینفوگرافی باید صحیح، معتبر و علمی باشد. شبکه‌های اجتماعی 
نیستند. جست و جو در کتاب‌های  برای گردآوری اطلاعات  اینترنتی منبع مناسبی  از سایت‌های  و بسیاری 
معتبر، مقالات، مجله‌ها، اسناد و مدارک معتبر، استفاده از پرسشنامه‌ها، مصاحبه و مکاتبه با افراد صاحب‌نظر و 
متخصص از روش‌های مناسب جمع‌آوری اطلاعات است. پس از جمع‌آوری اطلاعات، باید نکات مهم و کلیدی 

را استخراج کرده و تا حد ممکن آنها را خلاصه کرد.
)Mind Map( مرحله سوم : ایجاد نقشه محتوا، نقشه ذهنی

یا  ایده‌هاست که پیرامون یک نقطه مرکزی  از نمودارها برای نمایش موضوعات و  نقشه ذهنی مجموعه‌ای 
و طبقه‌بندی  تصویر کردن، ساختاردهی  ایجاد،  برای  ذهنی  نقشه  محوری کشیده می‌شود.  به‌طور  کلیدواژه 
ایده‌ها کاربرد دارد. با استفاده از نقشه ذهنی می‌توان به‌سرعت ساختار یک موضوع را شناسایی و ارتباط بین 

اجزای سازنده موضوع را درک کرد. استفاده از نقشه ذهنی بسیار آسان است.

را  تحقیق  می‌توانید حاصل  کنید.  ارائه  به کلاس  و  کرده  تحقیق  اینفوگرافیک  کاربردهای  مورد  در 
به‌صورت اینفوگرافیک تهیه کنید.
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برای استفاده از نقشه ذهنی یک برگ کاغذ بردارید، یک دایره یا بیضی وسط صفحه بکشید و عنوان موضوع 
موردنظر را درون آن بنویسید. سپس با اضافه کردن شاخه‌های مختلف متصل به مرکز، موضوعات جانبی را 
اضافه کنید. هر شاخه می‌تواند زیرشاخه‌های مختلف داشته باشد. می‌توان برای هر موضوع در هر شاخه از 

رنگ‌ها و شکل‌های مختلفی کنار موضوع استفاده کرد.

پژوهش
برای ایجاد نقشه ذهنی استفاده از نرم‌افزارهایی نظیر i Mind Map را تجربه کنید.

مرحله چهارم : اجرای اینفوگرافیک
پس از ایجاد طرح از اینفوگرافیک روی کاغذ، نوبت به پیاده‌سازی اینفوگرافیک می‌رسد. یکی از روش‌های 
اجرای اینفوگراف، استفاده از نرم‌افزارهای گرافیکی نظیر Illustrator است. این نرم‌افزار به علت امکانات و 

ابزارهای فراوانی که در اختیار طراح قرار می‌دهد یکی از بهترین انتخاب‌ها است.

مرحله پنجم : انتشار اینفوگرافیک
دو بستر چاپی و دیجیتالی می‌توانند در نشر اینفوگراف به شما کمک کنند. اینفوگراف تهیه‌شده را می‌توان 

روی وب‌گاه یا شبکه‌های اجتماعی به اشتراک گذاشت و یا آن را چاپ و تکثیر کرد.

فعاليت 
اینفوگرافیکی با یکی از موضوعات زیر انتخاب کنید و مطابق مراحل طراحی عمل کنید. برای مرحله كارگاهي

اجرا، از کارگاه بعدی کمک بگیرید و پس از چاپ، آن را به کلاس نصب کنید.
آب هست ولی کم هست، حیات‌وحش حیات زندگی، با طبیعت مهربان باشیم، وقت‌شناسی، نظم در 

زندگی،کاربردهای اینفوگرافیک

در این کارگاه قصد داریم اینفوگرافی برای 
موضوع از پیش تهیه‌شده، طراحی کنیم.

1  یک سند ایجاد کنید.
، Width: 70cm  بـــرای  سند  مشخـصات

 Color Mode: CMYK ،Height: 50cm
را در نظر بگیرید.

 كارگاه ٥     طراحی اینفوگرافیک
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2  پس‌زمینه اینفوگراف را ایجاد کنید.
یک مستطیل با ابعاد Width:70cm و Height:50cm در موقعیت X=0 و Y=0 ترسیم کنید. یک گرادیان 
شعاعی با مشخصات جدول 5 به مستطیل ترسیم‌شده اعمال کرده )شکل 96( سپس مستطیل ترسیم‌شده را 

با زدن کلیدهای میانبر Ctrl+2 قفل کنید.
3  یک‌لایه جدید ایجاد کنید.

شکل 96ـ تعیین نوع گرادیان

پارامترهااسلایدر سمت چپاسلایدر سمت راست

100%39/69%Location

21/48%2/73%C

12/5%1/56%M

1/55%0/78%Y

00K

را  اینفوگرافیک  پایه  اشکال   Pen ابزار  کمک  به    4
ترسیم کنید.

پس از انتخاب ابزار Pen روی نماد Fill در جعبه‌ابزار دابل کلیک 
کنید و کد رنگ را e2e3e 2 # قرار دهید. دقت کنید بخش 
 # 919090 رنگ  کد  با  را  مثلث‌ها  باشد.  رنگ  فاقد   Stroke
 Send Backward ترسیم کنید. سپس با استفاده از گزینه
از مسیر Object>Arrange مثلث‌ها را به پشت سایر اشکال 

ترسیم‌شده منتقل کنید.
5  سایه‌های تصویر را ایجاد کنید.

محل  در   # BBBDC0 رنگ  کد  با  مستطیل  یک  ابتدا   
مشخص‌شده ترسیم کرده و آن را به پشت منتقل کنید. سپس 
ابزار Direct Selection نقاط را به شکل مناسب  به‌وسیله 
ویرایش کرده و با استفاده از گزینه Gaussian Blur از مسیر 

Effect>Blur مستطیل را محو کنید.
6  عناوین اینفوگراف را ترسیم کنید )شکل 98(.

 –  639740  – 1765AF بـا کـد رنگ‌هـای  پنج  مستطیل 
      برای         عـناوین     8C3593    –   AA2031    –   DCA727
اینفوگراف در محل موردنظر ترسیم کرده، برای قسمت‌های 
 FDD00A –B4D44D –3A88C8 کناری از کد رنگ‌های

A65BA3 –  D64652 استفاده کنید.

شکل 97

شکل 98

جدول 5  ـ مشخصات گرادیان شعاعی
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7 با جداسازی اشکال، بخش میانی اینفوگراف را ترسیم کنید)شکل 99(.
 Line یک دایره با کد رنگ 629740 ترسیم و آن را به چهار قسمت مساوی تقسیم کنید. به‌وسیله ابزار
دو خط عمود برهم ‌روی دایره ترسیم کنید. دایره و دو خط را انتخاب، سپس از پنل Pathfinder گزینه 
Divide را انتخاب کنید. در وضعیت انتخاب شیء گزینه Ungroup را از منوی Object انتخاب کنید. با 
 Eyedropper چهار قسمت را از یکدیگر دور کنید. با انتخاب هر قسمت و کلیک توسط ابزار Selection ابزار

می‌توانید رنگ‌های متناسب را به هر بخش اعمال کنید.

8  بخش شفافی روی شیء ایجاد کنید.
یک نسخه مشابه از بخش سبزرنگ دایره ایجاد کرده و آن را دوران دهید. سپس یک گرادیان با زاویه 60 درجه 
 Stroke کلیک کنید تا رنگ Swap Fill and Stroke به آن اعمال کنید )شکل 100(. در جعبه ابزار روی نماد

با Fill جایگزین شود. سپس ضخامت Stroke را کمی افزایش دهید.

شکل 99

شکل 100

با فعال کردن پنل Transparency و کاهش میزان Opacity تا 30 درصد می‌توانید بقیه ترسیم را انجام 
دهید )شکل 101(.

9  اشکال ترسیم‌شده را گروه‌بندی کنید.

Transparency شکل 101ـ تنظیم میزان شفافیت در پنل

جابه جایی رنگ
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10  نسخه مشابه از گروه‌بندی ایجاد کنید )شکل 102(.

ایجاد  دایره  دیگر  بخش  برای سه  را  قبل  مرحله  در  ایجادشده  گروه 
کنید. به‌وسیله کادر Reflect و استفاده مناسب از گزینه‌های واقع در 
بخش Axis سه نسخه دیگر ایجاد کرده و در محل موردنظر قرار دهید.

11  بخش پایانی اینفوگراف را ترسیم کنید )شکل 103(.

برای ایجاد پس‌زمینه عنوان »     چرا اینفوگرافیک  « در سمت چپ اینفوگراف، 
یک مستطیل ترسیم کرده، آن را دوران داده و در محل موردنظر قرار 
دهید. به‌وسیله ابزار Add Anchor Point Tool یک نقطه در وسط 
ضلع پایین اضافه کنید. سپس به‌وسیله ابزار Direct Selection نقطه را 
کمی به سمت پایین کشیده و آن را به یک نقطه منحنی تبدیل کرده و 

یک گرادیان مطابق شکل 103 به آن اعمال کنید.

شکل 102

12  ترسیم را تکمیل کنید.

به‌وسیله ابزار Type Tool متن‌های موردنظر را به طرح اضافه کنید. برای درج تصاویر موردنظر می‌توانید از 
گزینه Place از منوی File استفاده کنید.

شکل 103ـ تعیین رنگ های گرادیان داخلی
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در این کارگاه قصد داریم با استفاده از ابزار Mesh یک 
کاربردی‌ترین  و  مهم‌ترین  از  یکی  کنیم.  طراحی  سیب 
ابزارهای نرم‌افزار Illustrator ابزار Mesh است. به‌وسیله 
این ابزار می‌توان یک شبکه مانند تور، روی شکل موردنظر 

ایجاد کرد و رنگ قسمت‌های مختلف را تغییر داد.
1   برای ترسیم سیب، یک دایره در سند جدید 

رسم کنید.
برای قسمت Fill رنگ سفید و برای بخش Stroke رنگ 
دایره  از  مشابه  نسخه  بگیرید. سپس یک  نظر  در  سیاه 

ترسیم‌شده ایجاد کنید )شکل 105(.

2   اشکال را ادغام کنید.
با استفاده از گزینه Unit دو دایره انتخاب‌شده را با هم 

ادغام کنید )شکل 106(.

3  منحنی بالای شکل را ایجاد کنید.
با استفاده از ابزار Direct Selection Tool نقطه تلاقی 
دو دایره در قسمت بالا را انتخاب کنید، سپس با کلیک 
روی نماد مشخص‌شده آن را به یک نقطه منحنی تبدیل 

کنید.

4   منحنی پایین شکل را ایجاد کنید.
ابزار  از  استفاده  با  کنید.  انتخاب  را  مشخص‌شده  نقاط 
قسمت  روی  کادر  یک   Direct Selection Tool
این قسمت  تا سه‌نقطه موجود در  مشخص‌شده بکشید 
انتخاب شوند )شکل 106(، سپس نقاط انتخاب‌شده را 

به سمت پایین بکشید.

5   با استفاده از ابزار Mesh سیب را رنگ‌آمیزی 
کنید.

قسمت داخلی سیب را بارنگ BD2C35 پرکنید. توجه 
کنید بخش Stroke بدون رنگ باشد.

Mesh كارگاه 6     رنگ آمیزی با ابزار 

شکل 104

شکل 105

شکل 106ـ تبدیل دو دایره به شکل سیب
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 Mesh Tool سیب را از حالت انتخاب خارج کنید. سپس ابزار
را از جعبه‌ابزار انتخاب کنید. در هنگام استفاده از این ابزار دقت 
کنید بخش Fill و Stroke فاقد رنگ باشند. برای اضافه کردن 
سطر به شبکه توری، روی خطوط عمودی و برای اضافه کردن 

ستون، روی خطوط افقی با ابزار Mesh کلیک کنید.
بعد از ایجاد خطوط Mesh برای تغییر رنگ نقاط موردنظر با 
استفاده از ابزار Direct Selection روی نقطه موردنظر کلیک 
کنید و از جعبه‌ابزار کادر Color Picker رنگ موردنظرتان را 
انتخاب کنید. کد رنگ‌های استفاده‌شده را می‌توانید در جدول 

6 مشاهده کنید.

در سایر نقاط مجاور نیز از همین کد رنگ‌ها استفاده‌شده است، می توانید تصویر یک سیب را وارد کنید و 
رنگ های مورد نیاز را از روی آن نمونه گیری کنید.
6   برگ را به سیب اضافه کنید )شکل 108(.

با ابزار Pen شکل برگ را ترسیم کنید. برگ را با کد رنگ 6C8F0D# و خط را با کد رنگ 91B644# روی 
برگ ترسیم کنید.

7   یک شبکه Mesh روی برگ ایجاد کنید )شکل 109(.
با استفاده از گزینه Create Gradient Mesh از منوی Object نیز می‌توانید شبکه توری Mesh را به تصویر 

اضافه کنید.

شکل 107

نقطه121110987654321
803539964F4D984E4D6A1421B7464BD06763D0716BD9938BDFA091660C1B780FIE6D0F1Fکد رنگ

شکل 108 شکل 109ـ ایجاد شبکه Mesh روی شکل

جدول 6  ـ کد رنگ نقاط



58

8  با استفاده از ابزار Mesh برگ را رنگ‌آمیزی 
کنید.

با استفاده از ابزار Direct Selection Tool نقاط 
مختلف را انتخاب و کد رنگ‌ها را مانند شکل 110 
نقاط  برای  دهید.  اختصاص  تعیین شده  نقاط  به 
مجاور هم‌رنگ از کد رنگ‌های مشابه استفاده کنید.

9   ساقه را به سیب اضافه کنید.
برای ایجاد ساقه از دو قسمت با گرادیان‌هایی که 

کد رنگ آنها در شکل 111 آمده استفاده کنید.

10   سایه را به طرح اضافه کنید )شکل 112(.

برای ترسیم سایه، یک بیضی با رنگ مشکی ایجاد 
 Gaussian Blur دستور  از  استفاده  با  کرده، 
سپس  و  محو  را  بیضی   Effect>Blur مسیر  در 
Opacity آن را کاهش داده، به پشت سیب منتقل 

کنید.

11   نقطه‌های روی تصویر را اضافه کنید.

برای اضافه کردن لکه‌های سیب ابتدا یک‌لایه جدید 
اضافه کرده، سپس با استفاده از ابزار Paintbrush و 
با رنگ سفید و با قلم مویی به ضخامت 3pt لکه‌های 
این  کنید.  ترسیم  مختلف  جاهای  در  را  موردنظر 

عمل با کلیک هم به‌راحتی انجام می‌شود.

شکل 110

شکل 111

شکل 112ـ ترسیم سایه طرح

 Paintbrush شکل 113ـ افزودن نقاط به وسیله ابزار
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 Selection بعد از اتمام کار به‌طور موقت لایه شامل سیب را مخفی کرده، لکه‌های ترسیم‌شده را به کمک ابزار
 Transparency شیء گروه شده را با استفاده از پنل Opacity انتخاب و در یک گروه قرار دهید. سپس میزان

کاهش دهید )شکل 113(.

فعاليت 
شکل 114 را طراحی کنید.كارگاهي

شکل 114

 شرایط عملکردمراحل کار
نمرهاستاندارد )شاخص‌ها/داوری/نمره دهی(نتایج ممکن)ابزار،مواد، تجهیزات، زمان، مکان و ...(

رنگ‌آمیزی اشیا

مكان : کارگاه استاندارد رايانه

تجهيزات : رایانه ای که نرم افزار گرافیکی روی 
آن نصب باشد 

زمان : 20 دقیقه

بالاتر از حد انتظار

رنگ آمیزی شکل با استفاده از fill و stroke   ـ ایجاد 
و ویرایش شبکه توری برای رنگ‌آمیزی پیشرفته ـ 
رنگ آمیزی کامل شکل و ایجاد سایه روشن یا طیف 

رنگی مورد نیاز با استفاده از شبکه توری

3

در حد انتظار
رنگ آمیزی شکل با استفاده از fill و stroke ـ ایجاد 
و ویرایش شبکه توری برای رنگ‌آمیزی پیشرفته  ـ 

تعیین رنگ یک نقطه و گروهی از نقاط شبکه
2

1تعیین رنگ fill و stroke شکلپایین‌تر از حد انتظار

ارزشیابی مرحله 3
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 كارگاه 7     برش با لیزر

شکل 115

1   یک سند جدید با ابعاد Width:29/7cm و Height:21cm ایجاد کنید.
2   مربع کف جعبه را رسم کنید.

یک مربع گوشه گرد با ابعاد جدول 7 ترسیم کنید. مربع ترسیم‌شده را در مختصات تعیین‌شده در شکل 116 
قرار دهید. دقت کنید که حتماً نقطه مرجع )Reference Point( گوشه بالا سمت چپ انتخاب ‌شده باشد. 
نقطه مرجع مشخص می‌کند که عملیات Transform که در اینجا تعیین موقعیت مربع ترسیم‌شده است، 
نسبت به کدام قسمت مربع انجام شود. در واقع نه نقطه مرجع در اطراف شیء ترسیمی شامل گوشه بالا سمت 
چپ، بالا وسط، بالا سمت راست و... وجود دارد، برای مشخص کردن این نقطه کافی است که آن را در پنل 

Transform مشخص کنیم )شکل 116(.

در این کارگاه آموزشی یک جعبه مخصوص 
جواهر را طراحی می‌کنیم. طرح را یک مرکز 

برش با لیزر اجرا کرده است )شکل 115(.

9/5cmWidth

9/5cmHeight

0/5cmCorner Radius

جدول 7ـ ابعاد مربع

شکل 116ـ تعیین نقطه مرجع
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3   سوراخ‌های کف جعبه را اضافه کنید.
چهار مستطیل تعیین شده در شکل 117 را با توجه به مشخصات آنها )جدول 8( ترسیم کنید و در موقعیت های 

مناسب قرار دهید.

XYنقطه مرجعWidthHeightشماره شکل

11 cm0/3 cm
گوشه بالا 
cm1/5 cm 5/25سمت چپ

21 cm0/3 cm
گوشه پایین 
cm10 cm 5/25سمت چپ

30/3 cm1 cm
گوشه بالا 
cm5/25 cm 1/5سمت چپ

40/3 cm1 cm
گوشه بالا 
cm5/25 cm 10سمت راست

برای تنظیم فاصله‌ها از پنل Transform واقع در منوی Windows استفاده کنید. چهار مستطیل ترسیم‌شده 
را از مربع گوشه گرد کسر کنید. برای این کار بعد از انتخاب هر چهار مستطیل و مربع گوشه گرد، روی نماد 

Minus از پنل Pathfinder کلیک کنید.
4  مربع درِ جعبه را رسم کنید.

یک مربع دیگر با ابعاد جدول 7 ترسیم کنید. مربع ترسیم‌شده را در موقعیت X:14cm و Y:1cm قرار دهید، 
نقطه مرجع گوشه بالا سمت چپ باشد. مطابق شکل 118 و جدول 9 اشکال مناسب را به مربع ترسیم‌شده 

اضافه کنید.

جدول 8 ـ تنظیمات محل و اندازه سوراخ‌ها

شکل 117

XYنقطه مرجعWidthHeightشماره شکل

10/9 cm0/6 cm گوشه بالا
cm1 cm 14سمت چپ

20/9 cm0/6 cm گوشه بالا
cm1 cm 23/5سمت راست

30/5 cm0/2 cm گوشه بالا
cm1 cm 14/9سمت راست

40/5 cm0/2 cm گوشه بالا
cm1 cm 22/6سمت چپ

50/7 cm0/5 cm گوشه پایین
شکل cm10/2 cm118 18/4سمت چپ

 جدول 9ـ ابعاد اشکال
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5 طرح الماس را به در جعبه اضافه کنید )شکل 119(.
به‌وسیله ابزار Polygonal Tool یک مثلث با ابعاد دلخواه ترسیم کرده و مشخصات درج‌شده در جدول 10 
را با استفاده از پنل Transform تنظیم کنید. سایر مثلث‌ها را با تهیه نسخه مشابه و قرینه کردن مثلث اول 
به طرح اضافه کنید. برای ترسیم‌های ردیف دوم از ویرایش مستطیل استفاده‌شده است. اشکال ردیف سوم هم 
از ویرایش مثلث به‌دست‌آمده‌اند. بین مثلث‌ها فاصله مناسب در نظر بگیرید تا هنگام برش مشکلی پیش نیاید.

از این شکل دو قطعه لازم است. یک نسخه مشابه از آن ایجاد کنید و به‌وسیله دستور Reflect آن را به‌صورت 
Vertical قرینه کرده و در پایین شکل ترسیم‌شده در محل مناسب قرار دهید.

XYنقطه مرجعWidthHeightشماره شکل

11/2 cm1/5 cm گوشه پایین
cm4/5 cm 16/6سمت چپ

جدول 10ـ ابعاد مثلث

شکل 119

6 دیواره‌های چپ و راست جعبه را رسم کنید.
 Minus و Unit مطابق شکل 120 و جدول 11 اشکال مناسب را ترسیم کرده و در صورت نیاز از دستور

استفاده کنید.

 جدول 11ـ ابعاد ترسیم شکل

XYنقطه مرجعWidthHeightشماره شکل

مستطیل 
گوشه بالا cm3 cm 9/5اصلی

cm12 cm 2سمت چپ

10/3 cm1/5 cm گوشه پایین
cm15 cm 2/5سمت چپ

20/3 cm1/5 cm گوشه پایین
cm15 cm 11سمت راست

31 cm0/3 cm گوشه بالا
cm15 cm 6/25سمت چپ

40/9 cm0/9 cm2پایین وسط cm12/2 cm

50/35 cm0/35 cm2پایین وسط cm11/9 cm120 شکل
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7 دیواره پشت جعبه را رسم کنید.
و  ایجاد   12 جدول  مشخصات  با  مستطیل  سه 
سپس دو مستطیل کوچک )شماره ١ و ٢ شکل 
از مستطیل بزرگ کم کنید. مستطیل  را   )121
ادغام  با شکل قبلی  را  را ترسیم و آن  شماره 3 

کنید )شماره 121(.

8  دیواره جلو جعبه را رسم کنید.
ایجاد و  با مشخصات جدول 13  چهار مستطیل 
سپس سه مستطیل کوچک را از مستطیل بزرگ 

کم کنید.

جدول12ـ ابعاد ترسیم شکل 121

XYنقطه مرجعWidthHeightشماره شکل

مستطیل 
cm3 cm 9/5اصلی

گوشه بالا 
cm12 cm 14سمت چپ

10/3 cm1/5 cm
گوشه پایین 
cm15 cm 14/5سمت چپ

20/3 cm1/5 cm
گوشه پایین 
cm15 cm 23سمت راست

31 cm0/3 cm
پایین سمت 

cm12 cm 18/25چپ

شکل 121

جدول 13ـ ابعاد ترسیم شکل 122

XYنقطه مرجعWidthHeightشماره شکل

cm3 cm 9/5مستطیل اصلی
گوشه بالا 
cm16 cm 14سمت چپ

10/3 cm1/5 cm
گوشه بالا 
cm16 cm 14/5سمت چپ

20/3 cm1/5 cm
گوشه بالا 
cm16 cm 23سمت راست

31/1 cm0/3 cm
گوشه بالا 
cm16 cm 18/2سمت چپ

شکل 122
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9 قفل را ترسیم کنید.
اشکال مناسب را با مشخصات داده‌شده در جدول 14 ترسیم کنید. )شکل 123(

XYنقطه مرجعWidthHeightشماره شکل

11 cm0/3 cm گوشه بالا
cm19 cm 18/25سمت چپ

20/5 cm0/8 cm گوشه پایین
cm16/3 cm 18/5سمت چپ

30/1 cm0/5 cm18/75پایین وسط cm16 cm

جدول 14ـ ابعاد ترسیم شکل 123

شکل 123

 10  زائده‌های قفل را ترسیم کنید )شکل 124(.
دو دایره کوچک به قفل اضافه کنید. شکل نهایی 

باید به‌صورت شکل 125 باشد.

11  طرح ترسیم‌شده را ذخیره کنید.

بعد از پایان ترسیم بهتر است ضخامت خطوط را 
به pt 0/25 کاهش داده و سپس سند را ذخیره 
کنید. مشورت با کارگاه برش لیزر به شما کمک 
برش،  مختلف  فنون  با  آشنایی  بر  علاوه  می‌کند 
پیشنهاد‌های آنها برای لایه‌بندی و استفاده از رنگ 
در طراحی را جویا شوید. هر کارگاه برش با لیزر، 
فنون منحصر به خودش را دارا است. از تکنسین 
بخش‌های  تمایز  برای  کنید  سؤال  لیزر  با  برش 
ازآنجاکه  می‌کنند.  استفاده  فنونی  چه  از  طرح 
 ai پسوند   Illustrator نرم‌افزار  پیش‌فرض  قالب 
است اما بیشتر کارگاه‌های برش با لیزر از نرم‌افزار 
Corel Draw و پسوند Cdr استفاده می‌کنند، 
نسخه‌های جدید این نرم‌افزار بدون هیچ مشکلی 

پرونده با پسوند ai را باز می‌کنند.

شکل 124

شکل 125
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3D كارگاه 8     طراحی با ابزار 

در این کارگاه می خواهیم روش طراحی اشکال سه بعدی 
را آموزش دهیم.

تصویری   Pen ابزار  با  و  کرده  باز  جدیدی  سند   1
شبیه شکل 126 ترسیم کنید.

2 ترسیم را به شکل سه بعدی تبدیل کنید.
 Effect/3D/Revolve مسیر  و  کرده  انتخاب  را  شکل 
پنل را اجرا کنید. در پنــل شــکل 127 تنظیمات را وارد 
کرده و کلید ok را انتخاب کرده تا شکل 128 به دست آید.

3 تصویری که قصد دارید به عنوان برچسب روی 
شکل قرار گیرد را وارد کنید.

4 تصویر برچسب را به نماد تبدیل کنید.
برای اینکه بتوانیم تصویر را روی یک شــی سه بعدی قرار 

دهیم باید آن را به نماد تبدیل کنیم.

شکل 126

3D Revolve شکل 127ـ کادر تنظیمات

شکل 128
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Symbols شکل 129ـ تنظیمات ایجاد Appearance شکل 130ـ پنل

Map Art شکل 131ـ کادر

شکل 132

اگر تصویر برچسب نقش بیتی باشد روی گزینه Embed در نوار کنترل کلیک کنید. به این ترتیب می‌توان 
تصویر را به عنوان یک نماد تعریف کرد )شکل 129(. پنــل Symbols را فعــال کنید. تصویر را به داخل پنل 

Symbols بکشید )شکل 129(.

5 نماد را روی یکی از وجوه شکل سه بعدی قرار دهید.

برای این کار باید دوباره جلوه 3D Revolve را با تنظیمات 
جدید اجرا کنیــم. پنل Appearance را باز کنید و روی 

جلوه 3D Revolve دابل کلیک کنید )شکل 130(.
در پنل باز شــده گزینــه Map Art را کلیک کنید تا کادر 

Map Art باز شود.
در قسمت Symbols برچسب وارد شده را انتخاب کرده و 
عدد گزینه Surface را تنظیم کرده )شکل 131( و دکمه 
Scale to fit را کلیک و کلید ok را فشار دهید تا شکل 

132 به دست آید.

6  سند را ذخیره کنید.

کاربرد گزینه Surface چیست؟كنجكاوي
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 كارگاه 9     نقاشی سه بعدی

فیلم شماره 10204: ترسیم نقاشی سه بعدیفیلم

 شرایط عملکردمراحل کار
نمرهاستاندارد )شاخص‌ها/داوری/نمره دهی(نتایج ممکن)ابزار، مواد، تجهیزات، زمان، مکان و ...(

تبدیل اشیای
 دوبعدی به سه‌بعدی

مكان: کارگاه استاندارد رايانه

تجهيزات: رایانه ای که نرم افزار گرافیکی روی 
آن نصب باشد

زمان:20 دقیقه

بالاتر از حد انتظار
رسم شکل اولیه در صورت نیاز ـ اجرای جلوه تبدیل 
شکل دوبعدی به سه‌بعدی و تنظیمات آن ـ اعمال 
ماسک شفافیت ـ رنگ‌آمیزی گرادیان با شبکه توری

3

رسم شکل اولیه در صورت نیاز ـ اجرای جلوه تبدیل در حد انتظار
2شکل دوبعدی به سه‌بعدی و تنظیمات آن

1اجرای جلوه سه‌بعدیپایین‌تر از حد انتظار

 معیار شایستگی انجام کار:
 كسب حداقل نمره 2 از مراحل تنظیمات مد رنگی و استفاده از نماد، سبک و جلوه گرافیکی

 كسب حداقل نمره 2 از بخش شایستگی‌های غیر فنی، ایمنی، بهداشت، توجهات زیست‌محیطی و نگرش 
کسب حداقل میانگین 2 از مراحل کار

ارزشیابی مرحله 4

آنچه آموختم:

...................................................................................................................................................................................... 1

...................................................................................................................................................................................... 2

...................................................................................................................................................................................... 3

فیلم را مشاهده کرده، تصویر زیر را ترسیم کنید.

برداشت
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جدول ارزشیابی پایانی

شرح کار:
1 تنظیمات مد رنگی 

2 استفاده از نماد، سبک و جلوه گرافیکی
3 رنگ‌آمیزی اشیا

4 تبدیل اشیای دوبعدی به سه‌بعدی
استاندارد عملکرد: 

با استفاده از ابزارهای پیشرفته محیط نرم‌افزار گرافیکی، درج نماد، استفاده از سبک و جلوه گرافیکی، رنگ‌آمیزی اشیا، طراحی سه‌بعدی،  انتخاب و 
تنظیمات مد رنگی را بر اساس دانش کسب شده انجام دهد.

   شاخص‌ها:

شماره
 مرحله کار

شاخص‌های مرحله کار

1
انتخاب تنظیمات رنگ برای مد نمایش یا چاپی سند ـ تعیین درجه شفافیت برای تصویر ـ ایجاد شکل جدید از طریق تغییر شکل اشکال موجود ـ گروه 

کردن اشکال ـ گرفتن خروجی jpg با تنظیمات دلخواه

ساخت و به کارگیری نمادـ اعمال سبک گرافیکی مورد نیاز ـ انتخاب جلوه گرافیکی ـ به‌کارگیری جلوه و تنظیمات آن2

رنگ آمیزی اشکال با ابزار های fill و stroke ـ  رنگ آمیزی با ابزار پیشرفته3

انجام تنظیمات جلوه تبدیل شکل دوبعدی به سه‌بعدی ـ اعمال ماسک شفافیت  ـ رنگ‌آمیزی گرادیان با شبکه توری4

شرایط انجام کار و ابزار و تجهیزات:
مکان : کارگاه رایانه مطابق استاندارد تجهیزات هنرستان‌ها

تجهیزات :  رایانه ای که نرم افزار گرافیکی روی آن نصب باشد
زمان : 70 دقیقه  )تنظیمات مد رنگی 10 دقیقه ـ استفاده از نماد، سبک و جلوه گرافیکی20 دقیقه ـ رنگ‌آمیزی اشیا 20 دقیقه ـ تبدیل اشیای دوبعدی 

به سه‌بعدی 20دقیقه(

معیار شایستگی:

مرحله کارردیف
حداقل

 نمره قبولی از 3 
نمره هنرجو

2تنظیمات مد رنگی1

2استفاده از نماد، سبک و جلوه گرافیکی2

1رنگ‌آمیزی اشیا3

1تبدیل اشیای دوبعدی به سه‌بعدی4

شایستگی‌های غیر فنی، ایمنی، بهداشت، توجهات زیست‌محیطی و نگرش:
مدیریت کیفیت ـ تفکر خلاق ـ زبان فنی ـ رعایت ارگونومی ـ كنترل حفاظتي الكتركيي و الكترونكيي تجهيزات ـ ایجاد 

اسناد الکترونیکی کاهش مصرف کاغذ ـ به‌کارگیری خلاقیت در طراحی
2

*میانگین نمرات

*  حداقل میانگین نمرات هنرجو برای قبولی و کسب شایستگی، 2  است.


